rAFL

FPS QUICK REFERENCE GUIDE

Fiber Processing Software (FPS) for the FSM-100 and LZM-100/110/120 Splicers

s

File Layout Machinelnfo.. Help
SO O dB R TO
Data Collection: FPS Data.txt

Options..
Main | Data | Loss Estimation | IPA Data
Controls

plice Loss
0012 —— Measured Los:
Estimated Los
— t Loss.
0.01-—— —— Deformatior
oo
Live Screencap (HQ) % 0.006
~ Measure loss (GPIB) 3
Measure loss (USB) 0.004
© Collect Data Only :
[/ Collect IPA Data 0.002 \\
Latest Results

Measured Loss:  [n/a|

Estimated Loss:  [0.00]

Offset Loss:  [0/000249]

Deformation Loss:  [(i001624)

TABLE OF CONTENTS

DATA COLLECTION APPLICATION.....ccetieeiiieii e e e e e e e e e e e e e e e e e e s s s s s s nn e e e e e e s
UPLOAD/DOWNLOAD APPLICATION ...ttt e e e e e s e e e e e e e e e e e e eneennnes
LIVE VIDEO FEED APPLICATION .....cciiiiiieiiii oot e e e e e e e e e e e e e s e s e
POWER METER READER APPLICATION ...t e s e e e e e e e e e eennnes
TECHNICAL SUPPORT INFORMATION ... e e e e e e e



QUICK REFERENCE GUIDE

Fiber Processing Software for FSM-100 Series & LZM-100/110/120

rAFL

DATA COLLECTION APPLICATION

The Data Collection application is used to collect various, user-specified splicer output data, to
include loss estimation and power meter measured loss data after a splice is completed. This
application gives users a tool to optimize splice mode parameters for improved splice loss and/
or PER performance. The collection of estimation data from the splicer, in-tandem with measured
loss, provides operators the ability to simultaneously optimize splice loss estimation for process
and quality control.

When the application is launched, it will enter the Main screen.

The main page contains four buttons as well as a switch for enabling Power Meter measurement and an option to
collect IPA data. Their functions and layouts are shown in Figure 1.

When pressed for the first time, both Collect Data (Single) and Run Auto Collection will prompt you to choose
a location to save data. The former will first collect data before prompting, while the latter will not allow you
to proceed before selecting a save location. FPS will save data collection instances as “.txt" files by default, so
in order to save to an Excel file, click File, then in the drop-down menu click Save as Excel File and save to the
desired location.

4 Data Collection: Optimization_ESMF-SMF28e+ txt s *’ |
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Figure 1

Figure 2 above shows the save prompt that launches on first run.

Collect Data (Single): Will collect parameters specified on the Data tab, as well as pre-arc, WSI, and post-arc
images. In order to collect splice data, the splicer must be in the “Finish” state after completing a splice. The file
previously saved will be automatically updated each subsequent time the Collect Data (Single) button is pressed.

Run Auto Collection: FPS will begin polling the splicer, checking if it is in a "Finish" state. If so, FPS will
automatically perform a Data Collection and update the selected or previously saved file. NOTE: Auto collection
cannot be run without an autosave location.

Data Screencap(LQ): Saves the current splicer image at 240x320 to the same folder as the data file. If no data file
folder has been chosen, you will be prompted to choose a location for the images.
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Live Screencap(HQ): Saves the current splicer image at 480x640 to the same folder as the data file. This image is
ONLY of the camera feed, no menus or overlays are captured. If no data file folder has been chosen, you will be
prompted to choose a location for the images.

This file-save will determine the folder that all images are saved to. The save location can be changed later by
performing a File»Save As... or loading a different Data Collection file.

Measure Loss (GPIB)/Measure Loss (USB)/Collect Data Only: A GBIP (General Purpose Interface Bus) or USB Power
meter stream is required in order to measure loss rather than estimate loss.

* When checking the Measure Loss (GPIB) button, you will be warned that failure to connect a GPIB will result in a
Communication Error, which will crash FPS and erase your data.

* If connected correctly, the splicer will read the value from the power meter and report it in a “Measured Loss"
column in the Data tab, as well as in the Loss Estimation tab.

 Alternatively, by selecting Measure Loss (USB), the splicer will collect measured loss data by attempting to read
a currently streaming USB power meter via the Power Meter Reader application in FPS. Collecting data with this
function activated will capture the live reading from the power meter. Because the Measure Loss (USB) function
captures a live reading, a reference value must be saved on the power meter before attempting to measure
splice loss.

* Post splice, the loss value may change if the splice is moved; therefore, data should be collected while the
connected power meter is streaming to FPS and before disturbing the finished splice in any way.

Collect Data Only: Retrieves splicer output parameters only and will not retrieve measured loss.

Collect IPA Data: Retrieves IPA data for a given splice. If this box is checked and there is no IPA data to be
retrieved, it will be ignored.

Figure 3 below shows a sample of five splices run with Run Auto Collection selected and the results subsequently
populated on the data screen.

Within the Excel file, Splice Data, Loss Estimation Data, and IPA Data will be available depending on what data
was collected.
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UPLOAD/DOWNLOAD APPLICATION

The Upload/Download application allows users to change, store, and transfer splice mode
parameters using PC control.

Furthermore, Upload/Download uses an Excel file to manage splice mode parameters. FPS is
compatible with previously saved SpliceLab Upload/Download forms, as well as provided templates.
UP/DOWN When opening Upload/Download for the first time, the user will be prompted to select a default
Excel file to read and write to. A recommended template is included with the install files.

Figure 4 shows the initial prompt to link an Excel file. seccoera ik .. =

e 1 You have not selected an Excel file to link Mode Download/Upload to.
' Please select one before continuing. You can change this file later in the
'File' menu.

Figure 4

The recommended Excel template for FSM or LZM is in the Release Folder shown in Figure 5.

/‘-\ -« . » FPS1.8b.1 Release Folderzip » FPS1.8b.1 Release Folder » v Search FPS 1.8b.1 Release Folder
Organize v Extract all files B= « [l d(
T Name : Type Compressed size Password ...  Size Ratio
Ml Desktop . AVR Install File folder
& Downloads ) FPS1.8b.1 for 32-bit PCs File folder
33 Dropbox . FPS1.8b.1 for64-bit PCs File folder
il Recent Places . Manuals File folder
ﬂi'\ FSM DownloadUpload Link File1.8.... Microsoft Excel Worksheet 1744 KB No 4697 KB 63%
4 Libraries | Installation Instructions.txt Text Document 1KB No 1KB 41%
| Documents * [°| LZM DownloadUpload Link File18...  Microsoft Excel Worksheet 1,763KB No 4697 KB 63%
D Music
Figure 5

When the Upload/Download application is opened, the Range option is Download/Upload: FSM DownloadUpload Link Fil...
selected by default which allows from 1 to 300 modes to be sent or received. Fle Link '
Alternatively, select the 7T Mode option to send or receive one specific splice

mode, e.g. (Mode 53) | Modes [ua |

Once you have selected a file, click the Link... button, located in the menu

=

bar. This will open the chosen file, from which you can send and receive 1 to 2

modes from.

Figure 6 shows the Upload/Download application box with the Range E} ) 1 Mode
option selected. In this instance, FPS can either receive or send splice © Range

modes 1-2. Clear All
Figure 7 (next page) shows the main page with Upload/Download

application and Link file open. Each mode received from the splicer will Ready en—
populate subsequent columns in the link file. Figure 6
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LIVE VIDEO FEED APPLICATION

LIVE VIDEO

i@ FPS

The Live Video application displays a live video feed from the splicer. By default, video will begin
streaming when this application is opened.

To save screen images, click Screencap as shown in Figure 8. The live feed will stop, and the “Save
As" dialog box will prompt the user to choose the file location for the captured image to be
saved. The video feed will resume when the dialog box is closed.
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Unless a save format and location is otherwise defined, images will be saved in “.bmp” format to the Documents
library by default.

NOTE: While live video is running, it will interrupt any other FPS program that is trying to control the splicer. For
example, if the Live Video application is open and the Ball Lens program is started, upon clicking Initiate
or Start, FPS will respond with an error message, citing an error communicating with the splicer. In order to
use a different FPS application, Live Video must be closed.

POWER METER READER APPLICATION

The Power Meter Reader application allows for reading of select USB Power Meters. This
application sends the power meter readings to the splicer for performing active fiber alignments
based on a max, min, or target loss condition, as defined by the user.

Parabolic Alignment constructs a graphical plot of the measured loss value vs. relative (X, Y)
position of the two fibers. Selecting Para Align prompts the splicer to execute two subsequent
scans of the fibers’ relative end face positions — first, a rough scan (StepL) and second, a fine scan
(StepF). From the initial scan, the resulting graph is a rough parabola, wherein the minimum

or maximum value is used to establish a new approximate range of X and Y fiber position values for optimum
alignment. The program then performs the fine scan, where the (X, Y) range established from the rough scan is
scanned again at finer intervals, defined by the input value for StepF. When parabolic alignment is complete, the
optimal (X, Y) position and the optimal loss value is displayed.

By default, FPS only supports the AFL OPM5, though
other power meter drivers are available and new drivers

can be developed if needed. Once the power meter’s
drivers are installed, simply clicking the Start Stream ' Thorlabs PM100USB
button will establish a connection and show loss in dB in

the “"PowerMeterReader” window.

READ
Figure 9 shows the value the splicer will use for -7.680 dBm

performing an active alignment, discussed below.

—
PowerMeterReader “

To set up active alignment with a splicer, follow the
splicer setup and power meter setup steps outlined in the
FPS instruction manual. As shown in Figure 10, use the S e StepF fm):
Active/Stop Align, Read Relative, and Start/Stop Stream O Max

buttons to manage the active alignment procedure from ® Mn

the FPS interface.

The splicer settings must be modified according to the
FPS instruction manual. If not, the splicer will be unable
to execute the active alignment procedure. Figure 9

CONNECTED |

To set up Parabolic Alignment in a connection through
a PC, follow the steps in the FPS Instruction Manual.

Thorlabs PM100USB

-7.368 dBm

Figure 10

© 2022, AFL, all rights reserved. Revision 1, 6.6.2022
Specifications are subject to change without notice.




f AFL QUICK REFERENCE GUIDE
r Fiber Processing Software for FSM-100 Series & LZM-100/110/120

In most cases, parabolic alignment is faster than
stam_i:_:\rd splicc_er aIignm_ent and doe'_s nofc require a StepL. gaml: seof om: [
specific setup in the splicer. Parabolic alignment collects O Max

a range of loss values from the power meter and plots ® Vin

a vertical parabola of the values. After the initial
parabola is plotted, a finer scan of the data near the
parabola minimal, or maximal, is completed to assess CONNECTED
the min. or max. loss.

Figure 11

The following parameters shown in Figure 11 can be customized as needed:

° Max/Min: Power meters may sign their losses differently depending on the manufacturer.
* Max should be selected if your Power Meter reports a negative value (i.e., moving from an initial loss of
-10dBm to -1dBm).
* Min should be selected if your power meter reports a positive value (i.e., moving from an initial loss of 10dB to
1dB).
e StepL (um) is the distance moved with each iteration during the Rough Alignment phase. The larger this value,
the larger and less precise the rough search area will be.
e StepF (um) is the distance moved with each iteration during the Fine Alignment phase. It should be less than the
StepL value to refine the initial results.

NOTE: Take special care to ensure that the proper OPM drivers are installed on the PC. OPM driver software should
have been supplied on a USB drive or CD with the purchase of the power meter. If the OPM driver is not
installed on the PC, FPS will be unable to connect to the power meter and will display an error.

TECHNICAL SUPPORT INFORMATION

If errors persist or if general support is needed, please call AFL Fusion Splicer Technical Support at 1-800-866-3602,
or visit our Technical Support Request web page.
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